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SECTION 1 – OVERVIEW 
 

What Is JBCourse? 

 
JBCourse Manager (JBCM), is an asynchronous course management system. Asynchronous 
means that neither student nor instructor needs to be online at the same time in order to conduct 
learning. Instructors typically post quizzes and assignments, facilitate text-based chat and 
discussion forums, or upload documents for student review. 
 
JBCM is built upon (runs on) the Moodle (www.moodle.org) platform, which is comparable and 
similar to other commonly used systems such as Blackboard, WebCT, Angel, Desire2Learn, and 
eCollege. 
 
Currently, there is no additional charge/fee to access JBCM for instructors or students. Access to 
JBCM is predicated upon an adoption of a J&B textbook for which an “ePack” exists 
 
Typical features of JBCM include: 
 

• Online Grade Book 
o Customizable by instructors to display percent, numeric grade, or letter grade 
o Instructors can create weighted sub-categories of grades 
o Instructors can export grade book as Excel Spreadsheet 

 

• Discussion Forums 
o Forums facilitate text-based dialogue, and do not occur in “real time” or live 

 

• Display Electronic Content / Documents 
o Customers can upload any  

 

• Calendar 
o Quizzes & Assignments (any added activity with an open/close date) 

automatically populate calendar 
o Instructors can manually add course-wide calendar events 
o Students can manually add reminders to calendar 

 

• Messaging System 
o Acts as both instant messenger & system email 
o Message history is stored for easy recall 
o Instructors can be notified at their personal email address whenever a message 

is sent to them through JBCourse 
Top 
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SECTION 1 – OVERVIEW (continued) 
 
JBCourse Manager is most commonly used in a “blended learning” environment. Blended 
Learning simply means that more than one educational delivery method is used, however, by 
today’s standard almost always is used to refer the combination of traditional classroom 
instruction augmented, supported, or used in conjunction with an online classroom / course. This 
allows critical skills to be taught online, with the application of those skills tested “in person”, for 
example. 
 
As of this writing (AUG2009) we currently run version 1.9.4 of Moodle. 

Key JBCourse Terms 

 

• ePack – This is sometimes called a “course cartridge”. It is the name given to represent ALL 
electronic documents uploaded into JBCourse which make up a virtual classroom 

• Asynchronous Learning – Learning which does not occur in “real time” or live, face-to-face. 
For example, an instructor might post assignments which students may not interact with for 
hours 

• Synchronous Learning – “real time” learning. Whether face-to-face or using “live” 
technology (e.g., Webex, Skype, GoToMeeting, Webcams, Video-conferencing) 

JBCourse Roles 

 
Our Course Management System relies on an assigned user role to determine what level of 
access is granted and to track activity.  
 
Below are the roles we currently assign JBCM users 
 

• Lead Instructor – This person is usually the one who has purchased / adopted our textbook 
and requires the highest level of access. A Lead Instructor can make content edits, deploy 
quizzes, create new quiz questions, view all student activity, add calendar events, and delete 
content. Pretty much “go and do anything” within a course. 
 

• Support Instructor – This is an assistant role. This person cannot make content edits 
(add/delete/move), cannot update quizzes, and cannot blast email students. This role is 
reserved for assistants who need a slightly higher level of access than a student. Support 
Instructors can facilitate discussion forum chat, view all student grades, and launch text-
based chat sessions 
 

• Student – This is the “lowest” level of access. Students cannot make content changes of any 
kind. They can only view their OWN grades, and change their OWN online profile. 
 

• Authenticated User – This is the initial role assigned to ALL users when they first create an 
account within JBCourse. If this user is ultimately to become a student, they would complete 
the registration process and are then automatically assigned the role of student by the 
system. If an instructor creates an account online, it requires a J&B representative to assign 
the level of instructor to said user. 

 
Top 
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SECTION 1 – OVERVIEW (continued) 

Account Creation, Course ID, and Enrollment Key Explained 

 
When a JBCourse ePack is requested, the named individual on the request form is designated 
the “Lead Instructor”. J&B creates that individuals login account, sets up the course, and emails 
generic student login information to the lead instructor. 
 
Students and additional Instructors must create their own account within the JBCourse system. 
To see the steps involved please review the Student Login Information Template. 
 
Student / Additional Instructor Account Creation Process 
 

• User completes registration form which asks for: 
o Username / Password 
o Valid Email Address 
o Full Name 

• User submits registration online 

• User receives email which requires them to click on hyperlink from within the email, to 
confirm their registration 

• User is directed back to JBCourse site to log in with newly confirmed credentials 

• Once logged in, the user is directed to a dashboard page, called “myJBCourse” 

• The user clicks on hyperlink titled "Click here to Search For Your Course" 

• From the next page, users search for their course by inputting the 10 character COURSE ID 

• Once the course is found, users click the hyperlinked course name and are presented with a 
security challenge. Entering the 16 character “Enrollment Key” grants access to the course. 

• The above is needed ONLY for the first visit; all subsequent visits only require the 
username/password. Users are directed to their course automatically. 

 
Course ID 
 

• The “Course ID” is a 10 character code which allows a student to locate their specific course 
from among the many being hosted on a given platform (www, www2, www3) 

• It is a critical piece of information to elicit from individuals requesting technical support as it 
helps validate they are legitimate users of the system and course. 

 
Enrollment Key 
 

• The “Enrollment Key” is a 16 character code which acts as a final security checkpoint to help 
combat automated spam bots, unwanted users, or accidental registrations. 

• It is a critical piece of information to elicit from individuals requesting technical support as it 
helps validate they are legitimate users of the system and course. 
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SECTION 1 – OVERVIEW (continued) 

How Is JBCourse Set Up? 

 

• Sales Representative submits request form via Data Warehouse 

• Request received by Distance Education Specialist (Bill Kimball) for fulfillment. 

• Named customer on request form is named “Lead Instructor” 

• Course live on site within 72 business hours typically 

STUDENTS LOGIN INFORMATION TEMPLATE 

 
PLEASE NOTE: The reference to “www2” below is merely to provide you with an idea of 
what the login directions will look like. You should ALWAYS double check the web 
address you have been given by your instructor as we currently host courses on “www”, 
“www2”, “www3”, “www4”, and “www5” 
============================================ 

Welcome,  

As part of your course, we will be using a virtual classroom environment, known as a JBCourse 
Manager. In order to gain access to this system, you will need to create an account and enroll in 
your course. 

Please pay close attention to the below instructions: 

1.    Visit http://www2.jbcourse.com 

2.    Under the heading "Is this your first time accessing JBCourse Manager?" click "Create 
new account" 

3.    Enter valid information in the text fields from the account creation page, including the 
image-based password and click "Create my new account" 

4.    You will receive an email confirming your registration from "JB Administrator" 

o      If you do not receive this email within 30 minutes, please check your SPAM and 
JUNK folders.  

o      If you've still not received it, please contact the Jones & Bartlett Technical 
Support by submitting a report to:  
http://www.jbpub.com/webmaster.cfm?problem=course_specific&course=JBCou
rse  (copy and paste into a browser if the link doesn't work) 

5.    Once you receive it, click the hyperlink in that email to confirm your registration and log in 
to the site: http://www2.jbcourse.com   

6.    Once logged in, you will be directed to you own personal dashboard, called 
myJBCourse. To the right of the page, click the link titled "Click here to Search For Your 
Course" (In the Search Courses block) 
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7.    From the next page, enter your Course ID Number into the search box & click GO: 
Course ID Number: xxxxxxxxxxxxxx 

8.    Locate your course, and click the course/class title (hyperlink) 

Top 

SECTION 1 – OVERVIEW (continued) 
 

9.    To protect your security online, we have password-protected each individual course – 
You will need to enter the following “Enrollment Key” in the open box and click Enroll Me 
In This Course: 
Enrollment Key: yyyyyyyyyyyyyyyy 

Relax! The hard work is now over – The next time you login to the website you’ll only need your 
username and password. 

NOTE: All users outside of the Eastern Time Zone must click the PROFILE link in the 
Administration Block, click EDIT PROFILE, and select their specific time-zone (Google 
UTC for your city, for example Boston is UTC -5) 
 
It is critical to adjust the time-zone setting in your profile to ensure local time is accurately 
reflected 

================================= 
RETURNING STUDENTS 
================================= 

1.    You only have to follow the above directions the first time you create an account  

2.    To log into your course, visit http://www2.jbcourse.com  

3.    Under the heading "Already have a JBCourse Manager Account?" enter your user name 
and password  

4.    Click Login  

5.    You will be directed to your personal dashboard, called "myJBCourse" You can enter the 
virtual classroom from here. 

 
Top 
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SECTION 2 – TOP TEN ISSUES 

Course Doesn’t Display / User Kicked Out of JBCM 

 
The number one culprit, when a user is “kicked out” of JBCourse, is that they do not have cookies 
enabled for their browser. Send the below information to any user who states they were “kicked 
out” or despite entering a correct username/password, cannot access JBCM: 
 
To enable cookies, follow the instructions below for the browser version you are using.  
 
Mozilla Firefox (1.0 final release and earlier)  

• Go to the "Tools" menu.  

• Select "Options".  

• Select the "Privacy" icon in the left panel.  

• Check the box corresponding to "Allow sites to set cookies".  

• Click "OK" to save changes. 
  

Netscape 7.1/Mozilla 5.0  

• Select "Preferences" from the Edit menu.  

• Click on the arrow next to "Privacy & Security" in the scrolling window to expand.  

• Under "Privacy & Security", select "Cookies."  

• Select "Enable all cookies".  

• Click "OK". 
  

Microsoft Internet Explorer 6.0+  

• Select "Internet Options" from the Tools menu.  

• Click on the "Privacy" tab.  

• Click the "Default" button (or manually slide the bar down to "Medium") under "Settings".  

• Click "OK". 
  

Microsoft Internet Explorer 5.x  

• Select "Internet Options" from the Tools menu.  

• Click on the "Security" tab.  

• Click the "Custom Level" button.  

• Scroll down to the "Cookies" section.  

• To enable:  
o Set "Allow cookies that are stored on your computer" to "Enable".  
o Set "Allow per-session cookies" to "Enable".  

• Click "OK".  
 

Microsoft Internet Explorer 4.x  

• Select "Internet Options" from the View menu.  

• Click on the "Advanced" tab.  

• Scroll down to find "Cookies" within the "Security" section.  

• To enable:  
o Select "Always accept cookies".  
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• Click "OK". 
 

 
 

Top 
SECTION 2 – TOP TEN ISSUES (continued) 

 
Netscape Communicator 4.x  

• Select "Preferences" from the Edit menu.  

• Find the "Cookies" section in the "Advanced" category.  

• To enable:  
o Select "Accept all cookies" (or "Enable all cookies").  

• Click "OK" 

Incorrect Time-zone Settings (“My Quiz Closed Early!”) 

 
Moodle does not allow for course-specific time-zones to be set. The only option is to set a 
system-wide time-zone or to allow the server location to act as the default. For JBCourse, this 
means ALL users are initially set on Eastern Time Zone. 
 
Despite being sent detailed information on how critical it is to update the time-zone, a common 
complaint is that a timed quiz has “closed early” – In almost all cases this student has not set their 
time-zone to the correct setting. 
 
Advise students to do the following: 
 

• Log in to their account 

• Click the PROFILE link from within the main classroom 

• Click EDIT PROFILE 

• Scroll to “Time Zone” and select the UTC code (Google UTC for your city, for example 
Boston is UTC -5) 

• Click UPDATE PROFILE button 
 

 “When I Try To Open PowerPoint, I only get a Blank/White Screen” 

 
This is a Microsoft bug. If an individual uses MICROSOFT XP or VISTA, plus they use 
MICROSOFT OFFICE 2007, plus MICROSOFT INTERNET EXPLORER, they cannot view 
MICROSOFT POWERPOINT embedded in IE.  
 
By default, all PowerPoint’s are set to “force download” to address this issue, but if a customer 
experiences a problem with a blank screen after clicking on a PowerPoint have the customer: 
 

• Refresh the page (F5) 

• Choose SAVE from the pop-up 
 
If a PDF files has been affected as well, the above process works the same to address the issue. 

Top 
SECTION 2 – TOP TEN ISSUES (continued) 

“As An Instructor, How Do I Add A Quiz?” 

 
Instructors make use of the quiz module the most, this question – about adding a quiz – is one of 
the most common taken. To add quizzes have the instructor: 
 

• Log in to their account 
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• Enter their classroom 

• Click the button titled TURN EDITING ON 

• Scroll to the module (chapter) they wish to add the quiz 

• Using the drop down menu titled ADD AN ACTIVITY select QUIZ 

• From next page, enter a quiz name, open/close date and other parameters 

• Scroll to bottom and click SAVE AND DISPLAY 

• From next page, use drop down menu titled CATEGORY to select the Chapter of Questions 

• Place checkmarks alongside desired questions and click ADD TO QUIZ button 
 
The Quiz is now live, the instructor can return to the main classroom 

Adding Content / Uploading Documents (Instructors) 

 
Instructors will often inquire as to which file formats can be imported into the course, and then ask 
“how” to import/upload such. While JBCM will display all electronic formats, the most commonly 
used formats include: 
 

• RTF 

• DOC 

• PPT 

• MP3 

• WAV 

• PDF 
 
To Upload Documents have instructors: 
 

• Log in to their account 

• Enter their classroom 

• Click the button titled TURN EDITING ON 

• Scroll to the module (chapter) they wish to add their content 

• Using the drop down menu titled ADD A RESOURCE select “LINK TO FILE OR WEB SITE” 

• From next page, enter a resource name 

• Under heading titled “LINK TO FILE OR WEB SITE” click CHOOSE OR UPLOAD A FILE 

• From pop-up click on the Chapter folder where you wish for the content to reside 

• Click UPLOAD A FILE 

• Click BROWSE 

• Search your PC for relevant file. Double click file when found 

• Click UPLOAD THIS FILE 

• When pop-up refreshes, find file name and click CHOOSE 

• Pop-up will close and return user to main content page 

• To keep a navigation pane visible, select “KEEP PAGE NAVIGATION VISIBLE” 

• Click SAVE AND RETURN TO COURSE 
 
 
 
 

Top 
SECTION 2 – TOP TEN ISSUES (continued) 

“I Created A Quiz Using Diploma, How Do I Import It Into JBCourse?” 

 
Diploma is the default Test-Bank / Quiz Generator software that comes packaged on our 
Instructor Toolkit CD-ROM’s. It allows instructors to easily create both print-based and online 
assessments.  
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JBCourse is built upon the Moodle platform, which doesn’t have a specific or proprietary quiz 
question format. Instead, JBCourse will accept the most commonly used formats. 
 
In order to use a quiz generated with Diploma (previously known as Brownstone, now known as 
Diploma or Wimba) an instructor must: 
 

CREATE QUIZ TO BE IMPORTED 

• With your test created, click FILE >> EXPORT >> BLACKBOARD LS5 
• Under heading QUESTION CONTENT PREFERENCES click CHANGE 
• Under FEEDBACK heading select "Include Field Information" AND Include Formatted 

Answer Text" 
• Click OK 
• Under heading CHOOSE A LOCAL DESTINATION click BROWSE 
• Find a folder you wish to save this file into 
• Click APPLY 
• Click EXPORT 
• Open the folder you just saved this package into. Unzip/Extract the contents of the zip 

folder 
• A file will be created with the .DAT extension - you will need this to import into the course 

IMPORT QUIZ INTO JBCOURSE 

• Log in to account/course 
• Click TURN EDITING ON 
• Find the existing quiz and click on the PAD/PEN icon 
• If creating a NEW quiz, click QUIZ from the ADD AN ACTIVITY DROP DOWN MENU 

o Name the quiz 
o Add open/close date & time 
o Add any other parameters you desire 
o Click SAVE AND DISPLAY 

• Click EDIT tab 
• Click IMPORT link 
• Choose BLACKBOARD (not Blackboard 6+) 
• Choose the chapter you want these questions to be associated with from the 

CATEGORY drop down 
• DESELECT "Get category from file" 
• Select NO from "STOP ON ERROR" option 
• Under heading "Import from file upload..." click BROWSE 
• Find the .DAT file you made previously 
• Double click that .DAT file 
• Click UPLOAD this file 

 

Top 
SECTION 2 – TOP TEN ISSUES (continued) 

“How Do I View / Download Activity Reports” (Or Grade-book) 

 
To generate an Activity Report, direct instructor to do the following: 
 

• Log in to their account 

• Enter into their course 
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• Click the link titled ACTIVITY REPORTS (REPORTS in older system) 

• Using drop down menus, select search parameters 
o To see results on computer screen select DISPLAY ON PAGE 
o To save the results as an Excel Spreadsheet, select DOWNLOAD IN EXCEL 
o To save the results in Open Document format, select DOWNLOAD IN ODS 

• Click GET THESE LOGS 
 
To view the Grade-Book, direct instructor to do the following: 
 

• Log in to their account 

• Enter into their course 

• Click the link titled GRADES 

• Students automatically populate grade-book when they join course 
 
 
To download the Grade-Book, direct instructor to do the following: 
 

• Log in to their account 

• Enter into their course 

• Click the link titled GRADES 

• Using drop down menu titled CHOOSE AN ACTION, under “Export To” select format: 
o Excel 
o Open Document (ODS 
o Plain Text File 

• From pop-up, select SAVE 

“Why Can’t I Get My Quiz To Open?” (Students) 

 
There are five main reasons why a student might not be able to access and/or view a quiz: 
 

1. The Quiz close date/time has passed 
2. It is password protected (instructor sets this) 
3. The instructor has restricted access to specific IP addresses 
4. The instructor has deployed a “secure” quiz, and the student has disabled JavaScript 
5. The student has already taken the maximum number of allowable attempts 

 

• Instructors – Log into your account 

• Click hyperlinked course name to enter classroom 

• Click TURN EDITING ON 

• Click QUIZZES link from ACTIVITIES block (left-hand side) 

• Click relevant hyperlinked quiz name/number 

• Click UPDATE THIS QUIZ 
Top 

 
SECTION 2 – TOP TEN ISSUES (continued) 

 

• Peruse this page to determine if: 
o Open/Close date has expired 

� If YES – direct student to their instructor 
o Multiple Attempts are allowed 
o The “Require Password” field is filled in 

� If YES – direct student to their instructor 
o The “Require Network Address” field is filled in 

� If YES – direct student to their instructor 
o If “Show quiz in secure window” is set to YES 
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NOTE: All support requests which are for any site which was given a unique URL (i.e., 
nypd.jbcourse.com) must be forwarded to the Distance Education Specialist (Bill Kimball) 

The Quiz close date/time has passed 

 
This setting is the sole discretion of the instructor. By default, J&B disables open/close dates so 
any date found to be active was setup by an instructor. If you find that a quiz date has passed, 
and a student is requesting access, direct them to their primary instructor. 

It is password protected (instructor sets this) 

 
This setting is the sole discretion of the instructor. By default, J&B does NOT assign passwords to 
quizzes. If you see an entry on this field, direct student to their primary instructor 

The instructor has restricted access to specific IP addresses 

 
This setting is the sole discretion of the instructor. By default, J&B does NOT assign a value to 
this field. If you see an entry on this field, direct student to their primary instructor 

The instructor has deployed a “secure” quiz, and the student has disabled JavaScript 

 
Having JavaScript blocked or disabled, or if the users version has not been updated, they may 
experience issues when attempting to open the quiz. Typically users will report a locked or frozen 
screen, quiz crashes, or being unable to view anything but a blank screen. 
 
First, determine (from steps outlined above) if the instructor has deployed the quiz in a secure 
window, then suggest users verify JavaScript is enabled (see below) 
 
Internet Explorer 6 or 7 

• Click the Tools menu. 

• Select Internet Options. 

• Click the Security tab. 

• Click the Custom Level button. 

• Scroll to 'Scripting' section. Select the 'Enable' radio button for 'Active Scripting.' 

• Click the OK button, and then click the Yes button in the confirmation window. 
 
Firefox 2 or 3 

• Click the Tools menu. 

• Select Options. 

• Click the Contents tab. 

• Select the 'Enable JavaScript' checkbox. 

• Click the OK button. 
Top 

 
SECTION 2 – TOP TEN ISSUES (continued) 

 
Safari 2 or 3 

• Click the Safari menu. 

• Select Preferences. 

• Click the Security tab. 

• Select the 'Enable JavaScript' checkbox. 

The student has already taken the maximum number of allowable attempts 

 
To check how many actual attempts a given individual has made on a particular quiz, do the 
following: 
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• Instructors – log into your account/classroom 

• Click the link titled QUIZZES (in ACTIVITIES block) 

• Find relevant Quiz, and click hyperlink titled “X Attempts” 

• Under “Preferences just for this page” select ALL ATTEMPTS 

• Click SAVE PREFERENCES 

• Find student in question to view number of attempts made 
 
If the student has taken the maximum allowable attempts on a given quiz (refer to above to find 
the max. allowable quiz attempts) direct them to contact their instructor. This setting is the sole 
discretion of the instructor. By default, J&B sets this to “1 Attempt”. 
 
JBCourse Manager’s quiz module is completely unlike any other online course J&B has, as it 
REQUIRES an instructor to set up their own quizzes. Our default setting of “1 Attempt” is part of 
the quiz deployment process, which instructors are free to change at anytime. 
 

SECTION 3 – TOP FIVE STUDENT CONSIDERATIONS 

“How Do I Reply To A Discussion Forum Post?” 

 

• Click the relevant forum link to enter the discussion forum 

• Find the discussion thread (topic) you want to read/reply to, and click the titled hyperlink 

• Click REPLY in the relevant post 

• Type your message in the blank text field 

• Choose SUBSCRIPTION (to receive or not receive emails when replies are made to post) 

• Click POST TO FORUM 

RSS Feeds 

 
Students (and instructors) sometimes express confusion regarding “what” an RSS feed is. 
 
To help round out the student experience, J&B has incorporated relevant RSS feeds into the 
ePacks we have available. An RSS (Really Simple Syndication) feed, at its essence, is an easy 
way to push relevant content from a website to a subscribed reader. This feed can be setup to 
send content or published articles to secondary websites, RSS readers, or subscriber email. 
 

Top 
 

SECTION 3 – TOP FIVE STUDENT CONSIDERATIONS (continued) 
 
To put it into perspective, in years past if I wanted to find the latest information on the BBC’s 
Health Page, I would have to physically surf to that page to find content changes. RSS feeds 
eliminate the need for me to go to the website, instead, having new content sent to me 
automatically. 
 
The number one question received about RSS feeds is whether or not reading the articles is 
“required” for the course. The short answer is, by default, it is not a graded item. With that said, all 
such inquires should be directed to the students instructor. 

Sending an Email From Within the Classroom 

 
Students can send messages from within the classroom. The JBCourse Message center allows 
for a hybrid between instant messenger and email. The “instant messenger” option only functions 
if instructors have enabled the VIEW ONLINE USERS option. 
 
To send an email from within the classroom a student would: 



 

15 

 

• Click on the PARTICIPANTS link 

• Find the classmate or instructor and click on their hyperlinked name 

• Click the SEND MESSAGE button 

• Enter message within blank text field 

• Click SEND MESSAGE 
o If recipient is online, they will receive instant notice and can reply immediately 
o If recipient is offline, they will see the email icon when the login next 

Update Online Profile, Add Avatar, View Activity 

 
While students have limited access to make changes within the classroom, they are allowed to 
make changes to their profile. This includes updating an email address, time-zone, username, 
password, avatar, or location settings.  
 
Additionally, if a student wants to see their documented activity, they can easily generate a “mini-
report” for their own use. 
 

Update Online Profile 

 

• Click the PROFILE link from the “Administration” block 

• To edit/update email, name, location, time, or username click EDIT PROFILE 

• To change password, click button titled CHANGE PASSWORD 

• To view all message received from beginning of course, click button titled MESSAGES 

Add Avatar 

 

• Click the PROFILE link from the “Administration” block 

• Click EDIT PROFILE 

• Scroll to section titled “Picture of”, click BROWSE 

• Find desired picture on computer (MUST be JPG or PNG format) 

• Double click image, this will redirect you back to profile page 

• Click UPDATE PROFILE 
Top 

 

View Activity (Mini Report) 

 

• Click the PROFILE link from the “Administration” block 

• Click either FORUM POSTS or ACTIVITY REPORTS 
 

SECTION 3 – TOP FIVE STUDENT CONSIDERATIONS (continued) 
 

“How Do I View JUST the Section I’m working on?” 

 
As a student, access is limited to “viewing content” rather than making changes/edits to the 
course. With that said, students do have the ability to “collapse” all online chapters to be hidden 
from view if the student would prefer to only see the chapter they are currently working on. 
 
NOTE: Instructors can truly HIDE entire modules from student viewing, which students have no 
control over. If an instructor has hidden a section, it will not appear at all for a student. 
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To collapse chapters/modules, a student would simply click the SQAURE icon in the right-hand 
column. To jump to new sections, simply use the JUMP TO drop down menu from the bottom of 
the page to choose a new chapter.  
 

 
SECTION 4 – TOP SEVEN INSTRUCTOR CONSIDERATIONS 

 

“What Quiz Question Formats Are Supported By JBCourse?” 

 
JBCourse Manager will support the following quiz question formats for direct import: 
 

• Blackboard 3+ (includes version 4 & 5) 

• Blackboard 6+ (entirely different format from prior versions) 

• Examview 

• WebCT 

• Respondus QTI 
 
Instructors who wish to author their own questions and then import them, or who have created 
quizzes in a word document are encouraged to use the GIFT format which Moodle/JBCM 
supports. 

GIFT is the most comprehensive import format available for importing Moodle quiz questions from 
a text file. It was designed to be an easy method for teachers writing questions as a text file. It 
supports Multiple-Choice, True-False, Short Answer, Matching and Numerical questions, as well 
as insertion of a _____ for the "missing word" format. Various question-types can be mixed in a 
single text file, and the format also supports line comments, question names, feedback and 
percentage-weight grades. Below are some examples: 

• Who's buried in Grant's tomb?{~Grant ~Jefferson =no one} 

• Grant is {~buried =entombed ~living} in Grant's tomb. 

• Grant is buried in Grant's tomb.{FALSE} 

• Who's buried in Grant's tomb?{=no one =nobody} 

• When was Ulysses S. Grant born?{#1822} 
 
Anyone who request more information on GIFT format can be directed to the DE Specialist (Bill 
Kimball) 
 
 

Top 
SECTION 4 – TOP SEVEN INSTRUCTOR CONSIDERATIONS – (continued) 

 

 “How Do I Add A Student Or Instructor?” 

 
In prior versions of JBCM, instructors were called “administrators” and could manually add 
students or instructors. This level of access has since been removed from instructors due to 
security concerns. 
 
To add a STUDENT – Please send them the login directions you received when you were first 
granted access to the course. 
 
To add an INSTRUCTOR – Please have that user create an account on the system, and then 
send a message to Jones & Bartlett Tech Support to assign instructor access. 
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SECTION 4 – TOP SEVEN INSTRUCTOR CONSIDERATIONS – (continued) 
 

 “How Do I Add Weights To My Grade-Book?” 

 
While the grade-book is sufficient to be used “as is” many instructors wish to assign specific 
values to a collection of assignments. For example, during an EMT-B course, an instructor may 
give 40+ “End of Chapter Quizzes”, 10 “Major Quizzes” and a Final Exam.  
 
These instructors may wish to have the sum total of a category (e.g., End of Chapter Quiz, Major 
Quiz) be worth a specified percentage of the overall student grade. 
 
As an example, let’s consider the following fictitious scenario – An EMT-B Instructor has a total of 
40 Chapter Quizzes, 5 Major Quizzes, and a Final Examination. This instructor wants the Chapter 
Quizzes to be worth 25% of the students overall grade, the Major Quizzes to be worth 25% of the 
overall grade, and the final exam to be worth 50% of the overall grade. 
 
The grade-book can easily handle this, and maintain the calculations automatically for the 
instructor, once it’s been setup to do such. It’s easiest if the instructor sets these categories up 
BEFORE the course begins - Here’s how an instructor would do it: 
 

• Log in to your account 

• Enter your classroom 

• Click the link titled GRADES  

• Using the drop down menu titled CHOOSE AN ACTION select CATEGORIES AND 
SETTINGS 

• Click the Pad/Pen icon alongside the top level category (almost always the name of the 
course which also contains the course ID number) 

• Ensure the aggregation method is WEIGHTED MEAN OF GRADES, click SAVE CHANGES 

• Click button titled ADD CATEGORY 

• Add category name (recommend you add the % to the name, for example, Chapter Quizzes 
25%) 

• Select SIMPLE WEIGHTED MEAN OF GRADES from aggregation 

• Enter percentage as number followed by decimal point and four zeros 

• Click SAVE CHANGES 

• Add additional categories as necessary in similar fashion. 
 
HOW TO ASSOCIATE A GRADED ITEM WITH A GRADE CATEGORY 
 

• Every assignment / quiz has the option of assigning a “grade category” usually located near 
the heading COMMON MODULE SETTINGS. Instructors simply select which category to 
associate the item with when creating the graded item. 

• Save any changes made to an assignment 



 

18 

 

 

 

 
 

Top 
 

 
 
 
 

SECTION 4 – TOP SEVEN INSTRUCTOR CONSIDERATIONS – (continued) 

 
Hide, Highlight, Collapse, or Move Chapter Sections (Modules) 

 
Instructors may want to hide one or more modules (chapters) from students. This is entirely the 
instructor’s discretion. Doing such is quite simple, but involves a bit of a manual process: 
 

• Have instructor log in to their account, and then enter into their course 

• When in main classroom, click the button titled TURN EDITING ON 

• To HIDE a module, click the EYEBALL icon from the right column of the module in question 

• To DELETE a modules, click the X icon from the right column of the module in question (it 
should never be necessary to delete a module, but it is up to the instructor) 

• To COLLAPSE all modules into a specific one, click the SQUARE icon (to undo, click the 
double square icon) 

• To MOVE a module, click the Up/Down arrow and specify where you’d like the module to 
move 

• To HIGHLIGHT  a specific module, click the LIGHTBULB icon 

 

Basic Question Analysis (“How Do I See What Students Got Wrong?”) 

 
Instructors may want to quickly see the correct and incorrect student responses for a given quiz. 
This helps an instructor understand if negative or positive trending is occurring. Basically, it’s a 
fast way to see if many people have scored a particular question incorrectly (therefore raising the 
possibility that it’s a problem with the question, or the class at large has an issue with 
comprehending the content) or perhaps only one student – out of many – has responded 
incorrectly (thereby possibly suggesting it’s the lone student who is struggling) 
 
Instructors must be logged into their account and in the main classroom to view this: 
 

• Click the QUIZZES link 

• Find the relevant quiz, and click the hyperlink “ATTEMPTS” 

• Under heading “Preferences just for this page” select ALL STUDENTS 

• Under heading “Your preferences for this report” put “20” into PAGE SIZE field 

• Select YES alongside “Show/ download marks for each question” 

• Click SAVE PREFERENCES 
 

“How Do I Blast Email My Students?” 

 
Instructors need to be logged into their account, and on the main page of their classroom. From 
there, they may blast email all participants in a given course. 
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• Click PARTICIPANTS link 

• Choose either SELECT all, or place checkmarks alongside individuals you wish to email 

• Use drop down titled WITH SELECTED USERS, and choose ADD / SEND MESSAGE 

• Type message into blank text field 

• Click PREVIEW 

• Click SEND MESSAGE 
 
 
 
 

Top 
SECTION 4 – TOP SEVEN INSTRUCTOR CONSIDERATIONS – (continued) 

 

“How Do I Add an Offline Assignment To The Grade-Book?” 

 
This is has become a frequently asked question. Many of the titles, for which ePacks exist, 
involve critical “hands on skills” which cannot be done online. Instructors do not want to maintain 
two separate grade-books to account for this. Our grade-book can accommodate offline activities. 
 
TO ADD AN OFFLINE ASSIGNMENT 
 

• Have instructor log into their account, and then enter the main classroom 

• Click button titled TURN EDITING ON 

• Scroll to relevant chapter that the offline activity correlates to 

• Using drop down menu titled ADD AN ACTIVITY choose OFFLINE ASSIGNMENT 

• From next page give the assignment a NAME 

• Enter a DECSRIPTION 

• Leave Grade at 100 

• Assign GRADE CATEGORY (if applicable) 

• Click button titled SAVE AND RETURN TO COURSE 
 
 
TO GRADE AN OFFLINE ASSIGNMENT 
 

• Have instructor log into their account, and then enter the main classroom 

• Click button titled TURN EDITING ON 

• Click the ASSIGNMENTS link from the Activities block 

• Find the relevant Offline Assignment 

• Click the hyperlink in the SUBMITTED column 

• From next page, change number in SUBMISSIONS SHOWN PER PAGE (as needed) 

• Place checkmark in ALLOW QUICK GRADING 

• Click SAVE PREFERENCES 

• Once page refreshes, use drop down menu under GRADE column to assign numeric score 

• Enter any individual feedback you wish your student to see in the COMMENT box 

• If you want your students to be notified via email of their grade, place checkmark in SEND 
NOTIFICATION EMAILS 

• Click SAVE ALL MY FEEDBACK 
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